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Lomputer Pduation 6

INTRODUCTION TO COMPUTER

Exercise - |

Salact the most appropriate answer,
The Computer and all equipments
atzachead 101t are called -

.v;:' B b

Qn

Software M Hardwares ‘
Naonitor d) CPU

It m

are set of instructions given
@ Computer.

a2 EHadware D Memory

o Softwarey  d)  Devices

=) Computer works by
measuning continuous: in  some
pho=cal quantity.

a2 Digital b) Hybrid

<  Anzloguev d) Monitor

= Collection of facts and figures is
czllad

2] Dztz b) Information

) Sofis=zred) Hardware

v Iz many offices Computer is used
for processing. o

z) Eev b) Wordv

<) Digit d) Software

=) MOcrosoft Windows is example of

system.
Sofiwzreb) Operatingy

¢} In‘ormationd) Data

vi) unit of Computer through
wrzh we can feed data into
compuier system.
2) Output b) Storage
¢) Input’ d) System

viii) is a device used to feed
pictures of images into Computer
sysiem.

z) Scznner” b) Mouse

¢) Keyboard d) Monitor

Z) The brain of the Computer system
>

z2) Monitor b) Keyboard

c) CPUY d) Memory

x) Al hardware devices are attached
directly or indirectly with :

z) HXeyboard b) Motherboardv

©) Processor d) Wires

QL Wirite T for True or F for Faise in front
of each of the following sentences:-

.‘I) The  Insteaction thil Il 14
computer whut 19 iy wiw bwiie,
woltware (1) |

W Data dw singalor of Twtain “".
i Computer fo n high T TP

(1) |
fv) D lsan axmnple of sl tly,
Moute Is called pointing ae/v « ¢4,

Seanner by an ingut deyiee, OF)
ed vl 1kt

V)
vi)
vil) RAM Iu aluo oul)
(ll!) | | - ‘ |
viil) Monltor ig n softyiare deyies (¥
Dot Matrix s nn exsrophe A pride.

Ix)
(r)

x) Flve operations Bre kg fuy,
working of n computer, (¥)

Q3: Fill In the Blanksi- |

i) Computer iy an Kleglronle 5evis

i) The example of softwme g 145

 Windew/Word o

iii) The shape of Keyboard e lire 5
simple type writer,

iv) Scanner is an_Input device,

v)  Memory holds dats and progszes,

vi) Hard disk is also called Wipgheziay
Dises/Fixed Dises

vii) CD stands for Compact 1isk

viii)Modem i shor foy

MODulator/DEModulzior,

Q4: Define Computer and narne ary S
fields where computer is used?
Ans: Definition

Compuler is an electronic deviee
which accepts data ag input, processes
stores and retrieves it in an zocurzie
way.

Application of Computers

Computers are used in many fields
of our daily lif.. Sorme of the ficlds in
which it is mostly used are given below,
(1) In Offices:

It is used for word processing
instead of type writers in zlmost 20
official as well as private offices,
(2) In Banks:

Banks keep most of their ;
and datas in computers Lo provide guice
services to their account nolders zn4

customers.
(3) Medicine and health Cares:

T R
oA A
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Cnn]pll‘(‘l.‘s are used ) dia
oasCS as well as Providing !
disance 10 the doetors iy thei Mediey)
35.&1-'“ gducation:

@ computers play very i

N(‘atinn. It IS being used in
i and Universitjog for edy,

. These are the most ;
,::;l'ponents of a Comput, m

llowin part

are
”"an physical parts of
can be touched by han

portan
er thege Dla;

a computer

ware. om, Monito :
::e examples of hardware, I and printer

are: :
sdﬂ';t is a set of instructiong
omputer to perform
ork- MS windows, computer
3 = examples of software,
306: Name the following pictures.

that helps

2 specific

the ¢
games etc

Mother bod Provessor

Qo Brfeﬂy explain the following.

(s) Scanner (b) Hard Disk

(0) Processor.

a) Scanners: :
It is one of the input unit of

Computer. It is used to feed pictures or

images into computer. It has following
properties. '
i) It is a photocopier machine in
shape \
(i) It is capable of recognition of
character and picture.
(iii) It uses laser beam.
b) “Hard Disks:
It is one of the storage devices. It is
also called Winchester Disks or Fixed

JE——

Digks. 1t ean «tore huge amount of data
a8 compared to all other storage devices
It is attached with motherboard of
computer gystom, It is more reliable
storage device.

€)  Processor:
Control processing unit is called
the brain of computer system. It

supervises and processes all operation
of the computer system.
Q8: How does a computer work.
Ans: Computer: '
It is an electronic device which

.accepts data as input, processes, stores

and reproduces it in an accurate way. It
is a general purpose machine that
DProcesses data according to a given set
of instructions. These instructions are
stored  either  temporarily  or
permanently. The computer and all
equipment attached to it are called
Hardware. The instructions that tell the
hardware what to do are called software.

- UNITNO: 2
INTRODUCTION TO WINDOW
| EXERCISE

Select the most appropriate answer.
A/An is a small picture with
a caption that represents a file,

Ql:
i)

~ folder, ' or ' program, on your
; computer. :
a)  Desktop- - b) Iconv
¢) Window d) File
The software program in computer .

ii)
. which is responsible to start and
© control  the' functionality -of
, computer is called

Software b) Operating Systemv

a)

¢) MsWord d) Windows

iii) After you have started the
computer, the area you are looking
at windows is called ___.

a) Windowsb) Desktop¥

c¢) Icons d) Hardware

iv) At the bottom section of the
desktop screen, there is a Dbar,
called the

a) Menu bar b) Task barv

¢) Toolbar d) Status bar

—
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VA icon lets you view and
change the volume level,

a) Volumer 1) Windows

¢)  Toolbar d) Keyboard

vi) is the name of a special folder
on the computer's desktop.

a) My Computer b) My Document¥

¢) Desktop d) File

vii) A storage medium in which _dnta
may be organized and maintained
in the form of files and folders is

called
a) File b) Folder
¢) Drivev d) Hardware

Q2: Fill in the blanks. '

i) GUI stands for Graphical user
Interface

ii) On the left side of the taskbar,

- there is an area with the word Start

iii) Notification area is also called
System tray

iv) My Computer icon provides access
to the resources on your computer.

v) When we delete a file or folder in
Windows. Windows sends it to the
Recycle Bin

vi) The icon In
to quickly access Internet.
vii) The Tool Bar contains icons to
immediately execute some of the
most often used commands.

Q3: Write T for True or F for False in front
of each of the following sentences:-

i)  The starting process of computer is
called Booting. (T)

ii) The desktop is usually different

. from one computer to another. (T)

iii) The right end of the taskbar
contains to clock and several
notification icons. (T)

iv) Double-clicking on an icon will
open or launch the file, folder, or
program. (T)

V) We can not restore the files or
folders that are located in the

_ Recycle bin. (F)

vi) Taskbar is an area at the top of a

window that contains the name of

the file or application i
window. (F) 2 i

is used

s

vid The Menu bar has commandg
organized in menus. (T)

Q4: Define the following terms

(a) Title Bar (b) Menu Bar
(c) Tool Bar (d) Desktop
() Title Bar:

This is an area at the top of g
window that contains the name of the
file or application in window.

(b) Menu Bar:

It has the program functiong
organized in menus.

(c) Tool Bar:

It contains icons to immediately
execute some of the most often used
commands.

(d) Desktop
After you have started the

computer, the area you are looking at is

called the desktop.

Q5: Write down two lines about each of
the following icons used in Window
operating system. ‘

() My Computer (ij) My Documents

(iii) Recycle Bin  (iv) Internet Explorer

Ans: My Computer:

It provides access to the resources
on computer. It provides access to

- computer drives and other peripherals,

My Documents:

. It is the name of a special folder on
the computer’s desktop. It is commonly
used to store documents, music,
pictures, downloads and other files.
Recycle Bin:

A deleted file or folder in windows
is sent to Recycle Bin where these can
be stored or permanecntly deleted.
Internet Explorer:

It is used to have quick access to
internet.

Q6: Write down steps for the following.

(2) To restart computer.

(b) To open a program using desktop.

(c) To rename of folder

Ans: To Restart Computer:

Following stops are taken for
restart.

1: Click the start button. The start
menu will appear.
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gadiant Computer Edueatioy o™

. Click Turn off computer, "Nirn of
2 mmpu:or ;iinlng box will ﬁmlﬁn? o
. Click the Restart optj ; '

3 bt v puon, Computer
) Toopen a program using a desktop,
f\bns: We can use following steps o (')’pvn

program like MS WORD, using
ﬁ,uowmi steps,
h Click on MS WORD
0 ot | icon on
i) Microsoft word progra i
G e, gram will be
iiiy Some slep can be used for
L any other program, SR
© To Rename Of Folder
ps:- ;
Right click on the folder.,
(ii) Click on the Rename option.
(i) axow you can give another name to
it.
(iv) OR Press F2 from keyboard to
rename the folder,

Qr: Name the following picture.

@ i 3
_ Start Menu
b & ’
Scroll Bar
(c)
P Sl 612 R28 il ColSl
Status bar

Q8: Label the following diagram.

- GE)

ige 18 tee pust ryve jok 1B e b

UNIT NO 3
COMMONLY USED SOFTWARE
EXERCISE

QI: Select the most appropriate answer.

(i) All the little grey boxes down the
left are called the tools and together

they make the :

n)  Toolboxv b) M"'"" har

¢)  Control box d)  Active box

(1) In MS Paint ____ I8 used to draw
n curve line,

n) Toolbox b) Curve tool”

¢) Control box d) Active box

iif) tool is useful to erase any
shape lLe. line, circle, any colour
from your drawing or an image.

a) FEragerv by Glass

¢) Rectangle d) Delete

iv) The selection tools are used o
crop/cut an area from a shape or a
(n)

a) Text b) Document

¢) Imagev d) Screen

v) option of typing tutor allows
‘you to practice as long as you like
in a single lesson.

a) Continuous lessons¥ b) Time

¢) Duration d) Screen

vi) A graph shows the words-

per-minute rate at which you type

each key.
a) Text b) Document

¢) Speedv d) Screen
vii) In MS Word shortcut key Ctrl+V is
used for

a) Cut b) Copy

¢) Pastev d) Redo

viii) The First Bar of MS Word screen is
' Bar. .

a) Titlev - b) Ruler

c¢) Formatting d) Text

ix) In Ms Word short cut key Ctrl+Z is

used for
a) Undov b) Redo
¢) Copy d) Paste

x) In MS Word we use the to

find words that have similar
meanings. '
a) F8 b) Grammar
c¢) Thesaurusv  d) Spelling

Q2: Write T for True a F for False in front
of each of the following sentences:-

(i) Paint is a drawing tool you can use
to create simple drawings like
rectangle, circle, arc, polygon and
line etc. (T)
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(i) Shapes tool group is used for
drawing shapes. (T)

(iii) Regular Lesson atarts  with @
limited group of keys and gradually
introduces new Keys. (T)

(iv) The Key Review lesson in typing
tutor creates phrases made from all
the keys you have learned so far.
(T

(v) Typing Tutor 6 does not maintain a

record of
personal history file. (F)

vi) The second bar in MS Word screen’

is Menu Bar. (T)

vii) In
is used for closing the document.
(F)

viii) The grammar checker analyzes
green :

your text and uses a wavy
underline to point out potential
trouble spots. (T) TR
Q3: Fill in the Blanks:-
i) Right at the
window is the status Bar.
ii) Shapes tool is used to
triangle and odd shapes
iii) When Show WPM
Typing Tutor
average typing
minute over
lesson or test.
iv) Clicking on
will bring up a visual display of the
keyboard while you are typing.
v)  With Split Screen you can separate
 the source typing material -from
what you type into two separate
~ windows. fhine
vi) Regular Lesson and Test is the
lesson and test type you will use
most in typing tutor. ;

vii) In MS Word short cut key Ctrl-O is

etc.

used for opening an existing

document.

viii) In MS Word Shift+F3 is used to

change the case of the text.

Q4: Write down steps to perform the
following:-

a) To rotate a picture is MS Paint.

b) To erase a freeform area in MS Paint

c) Changing case of text in MS Word

your progress in your:

MS Word short cut key Ctrl+F4:

bottom of the Paint

draw star,

is “selected
will display your
speed in words-per- -
the course of the

Key 'Board check box 3

—

d) Openinga fite from CD
Ans: (a) Rotatinga Picture in MS Paint

for rotating a picture are aq

Steps

follows.

i)y Insert your desired picture or dray,
shapes in MS Paint.

ii) Select the picture using Rectangle

gelection tool

iiiy Click on the Image menu and thep
click on Flip/Rotate option.

form area in MS Paint,

b)  To Erase a free
hould be taken tq

Ans: Following steps S

erase '
In the tool box, click free form to

1
) select a free form area.

9) Select the area you want to erase.

3) On the Edit Menu, click clear
selection.

"(c) Changing case of text in MS Word.

Ans: Following steps are taken for
changing case of text.

1) Select the text

9) -Click on the Format Menu.

3) Click on the change case option

4) Click on the desired case.

5) Click on the 0.K button.

(d) Opening afile from CD.
Ans: Following steps are recommended,

1) Double click on My Computer icon,

9) Double click on CD icon. List of
files will be displayed.

3) Click on any audio/video file. It will

be playing on Media player.
Q5: Define the following.
() Spray Paint tool of MS Paint
(b) Cut, Copy and paste in Ms Word |
(c) Media player Controls
(d) Status Bar.
Ans: Spray Paint tool of MS Paint:

In MS Paint there is a toolbox. It
contains various tools that are used to
complete various pictures and diagrams.
The toolbox contains following tools. -
() Linetool(ii) Curvetool
(iii) Shapes tool
(iv) Polygon tool and Rectangle tool etc
(b) Cut, Copy and Paste: '

These are short cut Kkeys that
perform following action.

B

Scanned with CamScanner



| 2

Radiant Computer l’.(luuninn o™
-_\

S e N o e e

Ctrl 4 X is ugeq 1o cut the g,
text. N

tex
text.

(C) Media "Iyer Coﬂh'olz
Windows Med

o ograms. teh AudioVideo

(d‘) Status Bar,

It is in the paint
information accordin
doing.

Q)G. Nm the followlnz plmm'

Color box

UNIT NO 4

THE INTERNET AND WORLD
WIDE WEB

EXERCISE

QI: Select the most appropriate answer.
i) Awebsite is collection of

a) Internet b) Wires

¢) Web pagesv d) Toolbars
ii) Web browserisa___ application,
a) Softwarev b) Hardware

¢) Search d) Modem

i) Each website on internet has a

unique address called
) Search Engine  b) Software
) URLY d) Webpage

o o

i8 used tq Paste the copied

Window and
Biveg
8 o what yoy are

iv) Google is an exampleof ____
a) FEmail b) Communication
¢) Search Engines

d) Yahoo
v) _  __ is network of networks.
a) URL b) Internet”

c)  Websgite d) Modem

Q2: Write T for True or F for False in front
of each of the following sentences:-

i) Internet is a local data
communication system. (F)

i) DSL is a method used to connect to
the internet. (T)

iii) In Cable Modem telephone wires
are used for data transmitting (F)

iv) The data inside computer is always
in digital form. (T) :

v) URL is a very high speed method of
accessing internet. (F)

Q3: Fill in the blanks:-
i)  WWW stands for World wide web
i) URL stands for Uniform Resource
' Locator example of search engine.
iil) Google/Yahoo/MSN is an example
of search engine.

iii) 'DSL stands for Digital subscriber
Line
iv) E-mail stands for Electronic nail

Q4: Define Global Data Communication
System.

Ans: It is defined as follows.

PaaeA global network of
interconnected computers that allows
communication”.

Q5: Name different methods of connecting
with internet.

Ans: Following three methods, are used

to connect to the internet.

(1) Telephone Modem

(2) DSL

(3) Cable Modem

Q6: Define the following

a) Www b) Web site

c) Webbrowser d) URL

Ans: These are defined as under

a) WWW: It stands for World Wide
Web. It is also referred to as the
web. It is the part of internet.

b) Web Site. It is a collection of web
pages maintained by an
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(c)

(d)

organization or an individual, For
example www.plv.com or
Www,cnn,com ete.

Web Browser. It is a software
application which enahlcg user t{)
display or interac} with texd.
images, videos, music, games anb
other information‘]ocated on we

pa Source loca or EﬂCh WEbSitC
gel l tq . .

i a special address
on mternet has Ho: 11

called URL for ?xample

w.w Yahoo. Com .
‘I‘;.R.L:- It stands for uniform

Resource locater.

Q7: Why we use search engine in internet.
Ans: Search Engine:

It is a software program that

searches, .collects and reports
information to specified terms.
Examples of commonly used search
engines are Google, Yahoo, MSN
ete, to search for information on the
web. For example, when we write
www.google.com.pk in address
bar of internet explorer, following
webpage of Google search engine

appears on computer screen

“Google Pakistan”.
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